MindView Online - Quick Start Guide

Overview
MindView Online is an online concept mapping program that allows users to organize their thoughts visually to create, share, and export mind maps to Microsoft Word, PowerPoint, and Google Docs. The program assists with the creation of citations and bibliographies, uses predictive text with TextHelp, and allows for adding photos, links, and text notes within a map.

To Use

Logging In:
Go to MindView Online Website: www.mindviewonline.com

Enter your user name and password, and click Login.

Logging off MindView Online

Click Admin and choose Log Off to log off MindView Online.
Creating or Opening a Mind Map:

Creating a new folder

Click **new folder** and enter the name of the folder.

Moving a mind map or folder

1. Select the mind map or folder to be moved.
2. Click the arrow icon and choose **Move** in the menu.
3. Select a destination folder in the dialog that opens.

Creating and Opening a Mind Map

Note: As you edit your mind map, your changes are saved automatically. You do not need to manually save your mind map before exiting it.

Creating a mind map from scratch

From the Start page, click **new map**.

Creating a mind map from a template

From the Start page, click **open template**.

- Select a template in the right hand pane. Categories include Recently Used, Top Maps, Business, and Education.
- The new mind map is opened in the map workspace, ready for editing. By default, it contains content from the template used, but you can edit it as desired.

Building a Mind Map

Inserting Map Elements

All mind maps contain a root representing the central idea or theme of the mind map. You develop your mind map by inserting branches and sub-branches around the root.
A **branch** is a branch inserted at the same level in the mind map as the currently selected branch. Branches connected directly to the root are called **main branches**.

A **sub-branch** is a branch inserted at the level below the currently selected branch in the mind map.

### Inserting a main branch

- Select the root.
- Do one of the following:
  - Press Enter or Insert.
  - Double-click the root.
  - Right-click the root and choose **Insert | Branch**.
  - Choose **Home | Insert | Branch**.
  - Choose **Insert | Branches | Branch**.

### Inserting a branch at the same level

- Select an existing branch at the level where you want to insert a new branch.
- Do one of the following:
  - Press Enter.
  - Right-click the branch and choose **Insert | Branch**.
  - Choose **Home | Insert | Branch**.
  - Choose **Insert | Branches | Branch**.
Inserting a sub-branch

- Select an existing branch to which you want to add a sub-branch.
- Do one of the following:
  - Press Insert.
  - Double-click the branch.
  - Right-click the branch and choose Insert | Sub-Branch.
  - Choose Home | Insert | Sub-Branch.
  - Choose Insert | Branches | Sub-Branch.

When you have inserted one or more levels of sub-branches, you can collapse or expand them as needed. For more information, see "Viewing a mind map".

Entering a root or branch label

To enter or edit a label, do the following:

- Select the root or the branch whose label you want to edit.
- Start typing to enter the label.

💡 You can also press F2 to edit the branch label.
Designing Mind Map

- Click Export tab.
- Select file type you want to create.
- Make formatting selections as needed.
  - Click Template tab to select from available templates for exported format (APA, MLA, etc.)
  - Click General tab to select which components of the mind map to export (map pictures, hyperlinks, title page, etc.)
- Click dropdown menu next to “Export to” to select where to export the file (local drive, Google Drive, or Microsoft Live).
- Click OK.

Right clicking on a branch brings up a menu of editing options.
Formatting a branch

As soon as you insert a branch in the map, a Format tab appears at the right of the ribbon. This tab lets you perform different operations on the branch, such as choosing a different fill color or selecting different text attributes. See "Formatting a branch" for more information.

To apply the same formatting attributes to all branches, it is easier to use the Design tab, whose predefined styles and design options apply to the entire map. See "Designing a mind map" for more information.
Deleting a branch

To delete a branch, do one of the following:

- Select the branch you want to delete and press Delete.
- Select the branch and choose Home | Insert | Delete.
- Right-click the branch and choose Delete.

The root cannot be deleted.

*If you delete a branch by accident, you can always cancel the deletion by choosing Home | Undo/Redo | Undo or pressing Ctrl + Z.*

Formatting a branch

You can format the root of your mind map or any of its branches.

Select the root or the branch you want to format. You can select several branches to give them the same formatting attributes; see "Selecting several branches" below for more information.

Click the Format tab at the right of the ribbon.

Choose formatting options as desired:

**Selecting several branches**

Selecting several branches at once allows you to apply the same formatting changes to all of them simultaneously.

- Click the first branch, then press and hold down the Ctrl key while clicking the other branches one by one.

Each of the branches you click becomes highlighted to indicate that it is selected.

- To deselect one or more branches, simply click them again while holding down the Ctrl key.

You can also select several branches by drawing a frame around them with the mouse. All branches contained within the frame become selected.
Moving a branch

As your mind map grows, you may realize that some branches do not belong where they are but should be moved to a different position. This topic describes how to drag a branch to a different position in the mind map, and how to cut, copy and paste a branch in the mind map.

Dragging a branch to a different position

You can drag an entire branch, including any sub-branches and objects attached to it, to a different branch of your map.

➢ Select the branch you want to move, and drag it to the required location.

As you drag the branch in the mind map, lines are shown to indicate where the branch will be inserted if you let go of the mouse button.

In the example below, the sub-branch labelled D is being dragged to a new position as a main branch directly under the root.

➢ Release the mouse button to insert the branch at the required position.

Cutting, copying and pasting a branch

You can cut, copy and paste any branch of your mind map. This allows you to copy or move an entire branch, including all its sub-branches and attached objects, to a different part of your mind map, at the same hierarchical level or at a higher or lower level.

Cutting a branch

➢ Select the branch you want to cut.
➢ Do one of the following:
Choose Home | Edit | Cut.
Right-click the branch and choose Cut.
Press Ctrl + X.

The cut branch is placed on the clipboard.

Copying a branch
- Select the branch you want to copy.
- Do one of the following:
  - Choose Home | Edit | Copy.
  - Right-click the branch and choose Copy.
  - Press Ctrl + C.

The copied branch is placed on the clipboard.

Pasting a branch
- Select the root or branch where you want to paste your cut or copied branch.
- Do one of the following:
  - Choose Home | Edit | Paste.
  - Right-click the root or branch and choose Paste.
  - Press Ctrl + V.

The cut or copied branch is added as a sub-branch of the root or branch you selected.

If you cut and paste a branch that is the starting point of a branch connection (see "Creating branch connections"), the branch connection will be moved with the branch. However, if you cut and paste a branch that is the end point of a branch connection, the branch connection is not kept.

Designing a mind map

You can customize the look of your entire mind map by applying design options to it.

💡 Most design options give you a live preview of their effect on the mind map. It is therefore easier to judge the overall effect once you have entered a few branches and sub-branches in the mind map.

- Click the Design tab at the right of the ribbon.

- Choose formatting options as desired:
  - Select a different style for the mind map under Design | Styles. Click the plus sign to display more styles.
Select a different page color for the mind map by choosing Design | Map | Page Color.

Reset the mind map to the default style by choosing Design | Map | Reset Style.

Applying a numbering scheme

You can apply a numbering scheme to the branches of your mind map, making it easier to identify where a particular branch belongs in the hierarchy.

- Choose Home | Detail, and click the label below the Numbering Scheme button to select a numbering scheme in the menu.

- Choose Home | Detail | Numbering Scheme to toggle the selected numbering scheme on or off. If you have not selected a numbering scheme, the default scheme will be used.

Changing the detail level

You can select how many levels of sub-branches should be displayed in your mind map.

- Choose View | Detail | Detail Level.
- Select the desired detail level in the menu.

At detail level 1, only the first level of branches below the root is displayed. Adding levels (up to detail level 4) will display more levels of branches (if any) in the mind map.

- To show all detail levels, select Show All Levels.

When printing a mind map, only the visible branches are printed. If you need to print the entire mind map, show all detail levels before printing. For more information, see "Printing a mind map".

Inserting text notes

Using the text editor in MindView Online, you can add a text note to the root or any branch of your mind map.

- If the text editor is not already visible, choose View | Panels | Text Editor, or click the Text tab at the right of the map workspace.

Creating a text note

- Select the root or branch where the text is to be added.
- Insert the text note by doing one of the following:
  - Click the text editor window.
  - Choose Insert | Insert | Text Note.
  - Right-click the root or branch and choose Insert | Text Note.
- Enter the text of your text note, and format it as desired using the options in the text editor.
You can also paste text from the clipboard.

If necessary, click **Undo** (or press Ctrl + Z) to undo the last change(s) made.

- Once you have finished editing your text, simply click outside the text editor, or select another branch.

**Once you are out of text editing mode, clicking **Undo** will undo all the changes made in the text note since entering text editing mode.**

As soon as you select another branch or element in the mind map, the text note is automatically saved to the root or branch. A paperclip icon appears to the right of the root or branch label to indicate the presence of an attached object. Clicking the icon displays a pop-up list of all objects attached.

**Inserting a citation**

You can add citations in your text notes to refer to the bibliography sources you have been using. You can also manage bibliography sources from the text editor. For more information, see "Using bibliography sources" and "Using citations".

**Opening a text note**

You can open a text note for reading or editing by clicking the paperclip icon on the root or branch and selecting the text note on the pop-up menu that opens. You can also click the arrow icon in the pop-up menu and choose **Open**.

**Renaming a text note**

- Click the paperclip icon on the root or branch.
- Click the arrow icon next to the name of the text note in the pop-up menu.
- Choose **Rename**.
- Enter a new name for the text note in the dialog that opens.

**Copying a text note to a different location**

You can copy a text note from the root or a branch and paste it on a different branch (or the root) in your mind map.
Click the paperclip icon on the root or branch.
Click the arrow icon next to the name of the text note in the pop-up menu.
Choose Copy.
Right-click the destination root or branch, and choose Paste.

Deleting a text note
Click the paperclip icon on the root or branch.
Click the arrow icon next to the name of the text note in the pop-up menu.
Choose Delete.

Inserting pictures
You can insert pictures on the root and branches of your mind map.

Inserting a picture from the Pictures panel
If the Pictures panel is not already visible, choose View | Panels | Pictures, or click the Pictures tab at the right of the map workspace.
Search the Pictures panel to find the picture you want to insert. For more information, see "Using the Pictures panel".
Drag the picture from the Pictures panel to the root or branch where you want to insert it.

The picture appears on the root or branch.
(Optional) Resize the picture by selecting it and dragging its edges until it reaches the correct size.

Inserting a picture from a local drive or cloud-based storage service
Select the root or branch to which you want to add a picture.
Choose Home | Insert | Branch Picture or Insert | Insert | Branch Picture.
On the drop-down list, choose an image location (local drive, Google Drive or Microsoft Live).

Do one of the following:

- For pictures on a local drive, select and upload the image file in the dialog that opens.

- For pictures on a cloud-based drive, log into the selected service in the dialog that opens (if required), and then select and upload the image file. You may have to grant MindView Online access to your files.

You can also insert a picture by right-clicking the root or branch where the picture is to be placed, choosing **Insert | Branch Picture**, choosing an image location in the submenu, and then selecting and uploading an image as described above.

The picture appears on the root or branch.

(Optional) Resize the picture by selecting it and dragging its edges until it reaches the correct size.

You can also add a picture by dragging it from your computer, network or device and dropping it on the desired root or branch.

**Replacing a picture**

To replace a picture on the root or a branch, simply insert a new picture. The old picture will be replaced with the new one.

**Removing a picture**

Do one of the following to remove a picture from the root or a branch:

- Right-click the root or branch, and choose **Delete | Branch Picture**.
Select the picture, and choose **Home | Insert | Delete**.

Select the picture and press Delete.

**Printing a mind map**

You can use the Print feature in MindView Online to get high-quality printouts of your mind map.

- Choose **Home | Print | Print**.

A print preview window opens in the browser.

- Adjust the print options as needed, and print the mind map.

**More information on the Print feature**

- If you try to use your browser's built-in Print feature (for example by pressing Ctrl + P or by accessing the Print command from a browser menu), you are asked to use the Print feature in MindView Online instead. The Print feature in MindView Online provides better results than the corresponding browser feature; for example, it allows you to print your mind map without also printing the ribbon.

- In order to print roots, branches and other elements correctly with pictures and background colors, you may need to manually select that background graphics should be printed. The print options available depend on the browser you are using; for more information, see the documentation for the browser. The illustration below shows where you can choose to print background graphics in Google Chrome.

![Print Options](image)

- Large or complex mind maps may become impossible to read when printed on an A4 or Letter format page and shrunk to size. Try switching to landscape orientation to make more room for the branches, or use the Branch Focus or Detail Level options to show fewer branches in the mind map before printing it. For more information, see "Viewing a mind map" and "Focusing on a branch".

- Some browsers may not support printing large maps directly from the browser. If you get an error message warning you of this, use a different browser, or export your mind map as a picture and then print the exported PNG file using any application that supports this. For more information, see "Exporting as a picture".
Exporting to Word

You can export your mind map as a Microsoft Word document.

Exporting to Word is only possible with a Premium account. For more information, see "Premium and Freemium accounts" under "Welcome".

- Choose Export | Export | Word.

  **Microsoft Word Export**

- On the Templates tab, select the template you would like to use.
- If you do not select a template, the default template will be used.
  - (Optional) Click Document Properties to enter information about the document such as title, subject and keywords.
  - (Optional) On the General tab, select which elements of the mind map should be included in the export, and select options for the table of contents and bibliography if desired.

By default, all text notes, pictures, hyperlinks and branch connections are included, and the exported file includes a title page and an image of the mind map.

- If you have used the Branch Focus or Detail Level options to show fewer branches in the mind map before exporting, the image in the exported file only shows the currently visible branches in the mind map. For more information, see "Viewing a mind map" and "Focusing on a branch".
Select whether you want to store the exported file on a local drive or on a cloud-based drive using Google Drive or Microsoft Live.

Click OK, and select a location for the exported file. If you chose to store it online, you may be asked to sign in to the selected storage service.

More information on the Word export feature

- You do not need to have Microsoft Word installed on your computer in order to export to Word. However, on versions of Windows prior to Windows 7, you need Word 2007 and above to open the exported document. You can also open the document in an earlier version of Word if you have installed the Microsoft Office Compatibility pack, available free from the Microsoft web site. From Windows 7, you can open .docx files directly in the default editor in Windows without having Word installed, although some of the more advanced content of the .docx file cannot be shown.

- By default, the exported file will have the same name as the MindView Online document. If you include a title page, the title of the MindView Online document is also used here.

- The branches of the map are exported to Word in the order in which they are displayed, starting from the top right in a clockwise direction. Each branch is exported as a paragraph heading at the relevant level; in other words, Heading 1 for main branches, Heading 2 for sub-branches, Heading 3 for sub-sub-branches and so on, using hierarchical numbering.

- The export of bibliography sources and citations is only supported from Microsoft Office 2007. For more information about sources and citations, see "Using bibliography sources" and "Using citations".

- Text notes are inserted directly in the Word file.

- Attached objects are not included in the export. Instead, the exported Word file contains hyperlinks to the attached objects in the original MindView Online document. When the reader clicks a hyperlink to an attached object, he or she is taken to the MindView Online site where the attached objects can be downloaded to his/her computer, network or device.

The reader can only access the online document on MindView Online and download the attached objects if he or she has a MindView Online account, and if the online document has been shared with the reader. For more information, see "Sharing files and folders".
Advanced Features or Other things to know about

- Online User Guide

Program Manufacturer Contact Info
Matchware Inc.
Tel: 1-800-880-2810 or 813-254-6644
usa@matchware.com

Cost:
- 1 Year Subscription: $15/month
- 2 Year Subscription: $13.50/month
- 3 Year Subscription: $12/month